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Introduction  
This guide is intended as a quick start-up guide to Gatekeeper Mapping for new users and 

those who have upgraded from Amais (A-Map). 

The guide is not intended to cover every single aspect of the mapping software but to 

provide you with the basics of the system that will allow you to utilise the software for your 

individual requirements. 

Explanations are provided for the different modules that are available and the functionality 

that will be provided from each one. 

There are worked examples that will cover the fundamentals plus explanations of the tools 

that are available.  

If you still have unanswered questions after reading through this guide, please refer to the 

imbedded help which is available in the bottom right hand corner of the screens and is 

indicated by the question mark symbol .  Alternatively, call the Support team on (01594) 

545040. 
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Part 1: Structure 
Field Map 
The Field Map mode provides the facility to view and manage individual fields’ mapping 

including field boundaries, scanned images, job data (including yield maps) and 

management zones.   

There is no module icon for Field Map. The individual fields’ mapping is viewed through the 

Field Map button on the Field Tab within the Fields module. Alternatively, where an entry 

for work is listed in a grid and the job has an accompanying map, there will be a globe 

symbol that, when clicked, will take the user to the associated map.  

Farm Map  
In addition to the features that Field Map contains, the Farm Map module provides a whole 

farm or estate view and allows the user to create their own map layers for drawing. 

Field information can be displayed for individual or multiple field groups. There is also the 

facility to import map data from the Farmade Amais mapping software. 

The Farm Map module is accessed through its own icon. 

Precision Farming Modules 
Depending on your precision farming requirements, the three optional modules; PF Actual, 

PF Target and JD Devices can be used on their own or in combination with each other. 

Precision Farming Actual 
Whilst the mapping modules provide the map data for field jobs, it is the Precision Farming 

Actual module which is used to bring captured spatial data into Gatekeeper. The module 

provides the import/export of actual spatial data from compatible devices e.g. a yield map, 

or an "as applied map". If a field boundary has also been captured, this too can be imported 

and ‘logged’ against the corresponding field. This module can be applied on its own 

alongside the mapping modules or in conjunction with other precision farming modules. 

Precision Farming Target 
As with the PF Actual module, PF Target works alongside mapping. It provides import/export 

of target spatial data for compatible devices e.g. a variable application or a soil sampling 

target map based on your own parameters. 

John Deere Devices 
The JD Devices module adds John Deere compatibility to Gatekeeper. The module supports 

the import and export of data between Gatekeeper and the GS3 2630, GS2 2600, GS2 1800 

and the original GSD4 displays.  
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Part 2: Getting started 
Field boundaries 
A Gatekeeper field boundary is a line indicating the perimeter edge of the field. This can be 

drawn using the on-screen tools, or imported from a GPS device or other source. If you are 

upgrading from the Farmade Amais mapping software, boundaries can be converted into 

Gatekeeper (see Importing Field Boundaries into Gatekeeper from Amais. 

Boundaries for different field areas 
Within Gatekeeper, a field is setup with its Field Details and Cropping Records. The Cropping 

Records can be for a Whole Field or Part Fields. If a field has one Cropping Record, it will 

have one boundary. 

If a field has more than one Cropping Record, each record can have its own defined 

boundary (known as a Field Region Boundary).  In this scenario, a boundary is allocated to 

the whole field record (to show the perimeter of the field as a whole) and also to the part 

field’s cropping records as required (Cropping Year Boundary).  

Note: if a field is not divided, its cropping and whole field boundaries will be the same. 

 

Example 

Long Five is a whole field and has not been divided. Its Whole Field boundary (the perennial 

boundary) is the same as its current Cropping Year boundary. As there is only one cropping 

record, the two boundary shapes will always be the same.

The ‘perennial’ 

Whole Field 

This seasons 

Cropping year 
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Example 

Lang Field has two cropping records; part A and B. Its Whole Field boundary will be for the 

field as a whole, but it can have two Cropping Year boundaries illustrating the two different 

parts of the field. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By creating a Whole Field boundary, it can be used as a template to create the cropping 

year boundaries for your field splits. 

  

NB. If creating boundaries for a part-field where a whole field boundary has been created, a 

red warning will be displayed on the Add New Field Boundary screen prompting you to 

create a Whole Field boundary. 

Creating a boundary from imported Amais data 
If you are upgrading to Gatekeeper Mapping from Farmade Amais (A-Map) then you should 

go straight to Part 3 – Importing Data from Amais (A-Map). 

If you are a new user or do not have any map data to import, you will need to start by 

creating your field boundaries (Creating a boundary for a whole field). 

The ‘perennial’ Whole 

Field boundary shows 

the field’s exterior. 

 

This season’s Cropping 

Year boundaries 

illustrate the two part-

fields; A and B 
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Creating a boundary for a whole field 
Field boundaries can be drawn using the MS Bing Maps as a backdrop (an editing license is 

required – please speak to the sales team at Farmplan if required). There are five backdrop 

layers available: 

I. Aerial 

II. Aerial With Labels (include road and location identification) 

III. Road  

IV. Ordnance Survey (1:125,00 & 1:250,000 scale) 

V. Collins Bart (a simplistic roadmap view) 

 

1. Ensure that the field to be drawn has its Map sheet and NG number entered under the 

field details (SEERAD FIS for Scotland). This will allow Bing Maps to find your field. If 

not, you will need to browse to your field location when prompted. 

2. Within the Fields module, select the field and click on the Field tab. 

3. Click on the Setup Boundary Map button that appears on the page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. The Add New Field Boundary screen will appear with the MS Bing Maps field finder 

option selected, click OK.  

Select a field and click 

on the Field tab 

Next, click on the Setup 

Boundary button 
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5. The field will be shown in the middle of the MS Bing Maps Field Finder screen providing 

the correct Map sheet and NG numbers have been entered in the Field Details screen 

(if not, navigate to the field location).  

6. Click on the Create Boundary button in the bottom right of the screen to start drawing 

the field boundary once the field is in view. 

7. The Field Boundaries Cropping Year layer will be selected and will be the top layer 

selected (Tip: the layer you are drawing on must always be the top layer). 

8. Select the Field Boundary Polygon tool and left click on the image to start drawing the 

field boundary.  

9. The Field Boundary Manager screen will appear allowing you to browse and select the 

field from the tree view that is having its boundary created. A tick box at the bottom 

of the Field Boundary Manager screen will recalculate the fields working and official 

areas from the map. Select this one if required and click OK.  

 

 

 

 

 

 

 

 

 

 

Field Boundary 

Polygon tool 

 

Left click clockwise 

around the field to draw 

the boundary 

Ensure that Cropping 

Year boundary is top 
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10. Continue drawing around the image to create the field boundary. Remember to use 

the right mouse click Headup Display options to finish and allocate the boundary (see 

Active Tool Options). 

11. Once completed, the Cropping Year boundary will be allocated and displayed on 

screen. As this is the first time a boundary has been created, a Whole Field boundary 

will automatically have been created by copying from the Cropping Year boundary. 

 

Now that the boundary has been created and stored against the field’s records, it will be 

viewable from the Field tab within the Fields module. 

NB. As well as utilising the MS Bing Maps field finder to locate and draw the field, 

cartographic layers holding stored map data can be used. This is covered further in Creating 

Field Boundaries from Amais polygons. 
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Creating a boundary for a part-field 
Creating a part-field boundary using Bing Maps: 

1. Select a part-field in the tree view of the Fields modules and click on the Field tab. 

2. Click on the Setup Boundary Map button that appears on the page. The Add New Field 

Boundary screen will appear. If a Whole Field boundary has not yet been created, a 

warning will be displayed: 

 

 

 

 

 

 

 

 

3. Select the tick box to create a Whole Field boundary first and then return to create the 

part field boundary or leave un-ticked and continue. 

If the whole field boundary has already been created, the warning will not appear. 

4. Ensure the MS Bing Maps field finder option is selected and Click OK. 

5. Continue with steps 5-11 of Creating a boundary for a whole field and draw around 

each part-field area. 

 

NB. To view Field boundaries, click on the Farm Map module>Map Layers >Field Region 

Boundaries. Ensure the correct Field Group has been selected using the Fields icon . 
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Splitting a whole field boundary 
Part-field Cropping boundaries can be based on a Whole Field Boundary which can be split 

by drawing a splitting line on the map, or by creating a headland and allocating either the 

headland area or headland remainder to the cropping record. 

1. See steps 1-5 of Creating a boundary for a part-field ensuring that a whole field 

boundary has been created. 

2. Select the Field Boundary Polygon tool and right mouse click inside the field. From the 

options that appear on-screen, select the second option Add field boundary based 

upon an existing field boundary. 

3. On the Field Boundary Manager screen, select the first part-field that will have its 

boundary created.  

4. On the right of the screen, you will see the Whole Field boundary that is to be used. 

Select the Split option. The Left of splitting line field will be the first part-field selected 

from the tree view. Tick the box to initiate the Right of splitting line allocation and 

using the drop down list, select the other field that is to be created during the same 

procedure (this allows you to split the whole field boundary into two boundaries) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the part-

field that will 

be created 

 

The Whole Field 

boundary that will be 

divided. 

 

 
Ensure the correct 

editing option has 

been selected. 

 

 
Select the 

appropriate part-

field that will be 

created on the right 

of the splitting line 

 

 
Tick box to calculate 

field areas 
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5. Remember to tick the box at the bottom of the page for the map to recalculate the 

part-field areas. Click OK. 

6. Draw a line through the field to indicate where the divide will occur. The right mouse 

button menu will allow you to divide the field at the splitting line or move the splitting 

line to its final position. 

 

 

 

 

 

 

 

 

 

 

 

 

The same principle can be applied to split a boundary down further to allocate a headland 

or headland remainder. 

Re-drawing a boundary 
If a boundary has been drawn incorrectly, it is possible to edit the boundary or even start 

again. This action will then replace the previous boundary. For further guidance on changing 

boundaries, please see Region management. Please note: A field boundary cannot be 

deleted, only re-drawn. 

1. Within the Fields module, select the field and click on the Field tab. Click on the Field 

Map button to bring up the Field Map screen. 

2. Ensure the Field Boundaries Cropping Year layer is top and select the Field Boundary 

Polygon tool. 

3. Right click inside the field boundary and select Find and replace field boundary from 

the options that appear. A caution message will appear informing you that “changes 

made to a field region’s boundary will be seen in all the years that the region has been 

used”.   If the boundary change is applicable for this year only or is not to affect the 

Two points have been 

drawn on the map 

indicating the field ‘split’ 

line. This can be moved 

if required 
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boundary of the region in previous years, exit to the Cropping Planner to change this 

year’s cropping record to another existing or new region. 

4. Click Yes to proceed. You will notice that the original boundary will be coloured with 

purple spots. Using the mouse, left click on the screen to draw the new field boundary 

ignoring the original. 

Hint: using the Line Grabber tool, you can grab drawn points for accuracy. 

5. Once the boundary is finished, right click and select Finish and allocate field 

boundary. Your new boundary will have replaced the original. 
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Part 3: Importing data from Amais (A-Map) 
Map Data can be imported from Amais into Gatekeeper. This can include: 

 Licensed OS map data  

 User defined layers 

 Field boundaries 

 Plan layers 

 Spatial Job Data such as Yield 

 

If you intend to use data from Amais to create field boundaries in Gatekeeper, it is 

recommended that the Amais Field Boundary layer is used. All Amais map layers imported 

using this option are imported into Gatekeeper as Cartographic Layers. 

Importing an Amais dataset 
1. From the main Setup option, browse to Mapping>Amais Dataset Direct Import. 

1. The Amais Dataset Direct Import screen will be displayed.  Browse to and select the 

appropriate Amais dataset from which you wish to import data  . This should be 

the default C: drive\Farmade\Map_Program\. The dataset name will be listed 

underneath. 

2. In the tree view, highlight the individual layers that are to be imported. 

3. If this is the first time that the layers are being imported, select the Add new layers 

option. On subsequent data imports, you may select the option to Merge layers by 

name. This will prevent duplication of layer names in the Cartographic node of Farm 

Mapping. 

4. Click on the Import button. 

5. The Map Preview screen will appear displaying the layer(s) that are being imported. 

Click OK to import the layers or Cancel to discard. 

6. Once the layers have been imported, the Amais Dataset Direct Import screen will 

appear and the tree view will be left without the Amais layers. 

7. Close the screen and browse to the Farm Map module to view and check the imported 

data. NB you will only be able to view the imported data if you have a field boundary 

created (see section 2.4). 

8. Expand the Cartographic Layer Groups node in the Map Layers tree view.  Any 

imported Amais field polygons will be found within the Imported Amais Fields group, 

whilst any Plans from the Amais Plan Layer will appear in a group called Imported Plans 

(year name). 

9. Browse through the Imported Cartographic Map Layers selecting the layer to be 

displayed. 
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NB. A Copyright acknowledgement can be added from the Tools>Options>Site>Reports. This 

should be displayed if Ordnance Survey data is used for example. 

Creating Field Boundaries from Amais polygons 
In this example, instead of using the MS Bing Maps Field Finder to locate and create a field 

boundary, a field boundary will be created based on your imported Amais Field Polygons 

(see above).   

1. Within the Fields module, select the appropriate field and click on the Field tab. 

2. Click on the Setup Boundary Map button that appears on the page. 

3. Select the option to Use existing farm map cartographic layers and click OK. 

4. The Farm Map screen will appear. Within Cartographic Layer Groups, open the 

Imported Amais Fields group and select the Field polygons for year layer that you wish 

to use (you may have several year layers each with different polygons reflecting the 

different field splits in each year) that will be the basis of the new field boundary. 

5. Using the Scale to box tool and Scroll Bars, navigate to the field. 

6. Select the Field Boundary Polygon tool. 

7. Ensure that the correct boundary layer has been made top. Initially, ensure the Field 

Boundaries Whole Fields layer is uppermost to create a Whole Field boundary. If 

Select the Map Layers icon to 

choose the visible map layers 

Select the imported Amais map 

layer from the Cartographic Group 
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however you are creating a Cropping Year boundary, ensure that this layer is 

uppermost. 

8. Right click in the field that is to have the boundary logged (instead of drawing around 

the field, you are able to use an existing polygon). From the right mouse button menu, 

select the option to Add field boundary based on any underlying field map polygon 

which in turn will give you the option of selecting the appropriate field polygon/island. 

Choose Find complex polygon to select a single whole polygon. 

9. The Field Boundary Manager screen will appear. Select the relevant field from the 

tree view and click OK. 

10. You will be returned to the Farm Map screen with the boundary now allocated. 

11. Now repeat from Step 7 onwards for all other fields remembering to click Save as you 

work. 

Exporting Field Boundaries from Amais. 
1. Within Amais, click on File>Export Map Data... 

2. On the Map Data Export screen that appears, select the File Type as Farmade CSV 

Boundaries and click Next. 

3. Browse to and select the folder that is to receive the boundaries and click Next. 

4. This will bring up the Export Map Data As CSV Files screen. On the Field Boundaries 

tab, select the field boundaries that are to be exported from the highlighted farm 

name.         

5. Once you have made your selection, click Export. 

Before importing field boundaries into Gatekeeper, ensure that the field details have been 

entered in Fields module>Setup Fields. The exported Amais field boundary file name will be 

prefixed by the letter B. This indicates that the file is a CSV boundary type. If the file name 

was used to create a new field (instead of linking to an existing field name within 

Gatekeeper) the field name would appear on Gatekeeper prefixed with a ‘B’ until edited. 

Importing Field Boundaries into Gatekeeper from Amais. 
This method of boundary creation will not create a Cartographic layer of imported data. 

1. With the field details entered on Gatekeeper, browse to the Devices module. 

2. From the tree view, browse to and select Farmade/Generic>Field 

Boundaries>Boundary CSV (WGS84).  

3. Once highlighted, click on the Device Sync button at the top of the page. 
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4. On the Device Synchronisation page, click on the Import tab. Browse to the folder 

that the Amais boundaries are saved in through the Path picker .  
5. The files to be imported will be displayed in the grid and will be highlighted Green 

indicating that they are boundary files. 

6. Link the source device boundary (Amais boundary) field to the correct Gatekeeper 

field by double clicking in the appropriate cell in the Gatekeeper Destination - Field 

column. Use the field selector screen to select the field that is to be matched to the 

imported field boundary. 

 

 

 

 

 

 

 

 

 

 

 

Select the 

Devices module 

Click on 

Device Sync 

 

Select the 

Boundary 

CSV device 

type 

 

Click in the 

Gatekeeper 

destination column to 

select the field from 

your list that the 

boundary is for 

 

Click to import 

 

Tick the Import 

selector to allow the 

field to be imported 
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7. Once the fields have been linked, tick the Import selector box. 

8. Click on the Import button at the bottom of the page. The Field Map page will appear, 

displaying the imported field boundary. The boundary is geo-referenced and so the 

MS Bing Maps can be displayed behind the boundary. Use the mapping tools to adjust 

the boundary if required. 
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Importing Job Data into Gatekeeper 
Job data (such as a yield map or N sensor scan) can be imported into Gatekeeper and stored 

against the field records. The job map is then viewable by clicking on the appropriate field 

operation within the Fields module. 

Step 1: Exporting job data from Amais 

1. Within Amais, click on the PF Information and Application Layers module icon   

2. In the side bar on the left of the screen, click on the PF Manager button. 

3. Browse through the settings and drop down list to select the Year, Farm, Fields and 

Group type applicable for the export i.e. Yield. 

4. Select the jobs within the grid and either Export or Export All. 

5. Select the destination file for the export. This is the location that you will direct 

Gatekeeper to in order to import the data. 

Step 2: Importing Job Data into Gatekeeper 

1. Ensure that the field(s) that are to be imported have been setup in Gatekeeper and 

ensure you are in the correct year for the data to be imported into. 

2. Click on the Devices module. In the tree view on the left, browse and select 

Farmade/Generic>Farmade Actual Data>Amais Actual Data. 

3. Click on the Device Sync button at the top of the page. The Device Synchronisation 

screen will appear with Amais Actual Data highlighted in Blue. Work through the 

Import Option tick boxes on the screen (note:  Historic Yield Maps Mode allows you 

to import yield data and associate it with a pre-existing primary output job without 

duplicating output recordings. This is important if you are linking Yield maps to data 

previously converted from MultiCrop). Click on the Import tab. 

4. Navigate to the path of the saved files and the Data to Import grid will be populated 

with the job entries. Double click in the cell under the Module column on the job line 

that will be imported. The Gatekeeper Destination Job and Field screen will appear. 

Select the Plan/Recording that the data is to be imported to (this could be a previous 

plan/recording if the record already exists or you can create a new plan) and click OK. 

5. The Gatekeeper destination columns will have been populated for that line in the grid 

with the selected details. Click on the Import button.  

6. The Recording Setup screen will appear if the Preview Imported Data tick box has been 

selected (see Import Options – step 3). Click OK. 

7. When all data has been imported, OK out of the Device Synchronisation screen. To 

view the data, browse to the appropriate field record and double click on the globe 

symbol that will appear next to the entry in the grid. 
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Part 4: Field Groups 
Each Cropping Record (or field) is allocated to a Field Group. As each cropping record can 

have a boundary, the Farm Map mode allows the user to view multiple boundaries within a 

field group.  

One or more field groups can be displayed at any one time and will set the visible map 

extents on the screen. Therefore, consideration must be made to how your field groups are 

structured and this may need to be reviewed if you are new to mapping. It is recommended 

that a field group should be a geographical area e.g. farm. 

Viewing field boundaries for the whole farm 

1. Click on the Farm Map module  . 

2. Click on the Fields icon  on the left hand side of the map screen and highlight the 

Field Groups to be displayed from the tree view.  

3. The fields Cropping Year and Whole Field boundaries can be viewed by selecting the 

appropriate Field Region Boundaries layer from the Map Layer icon . The map 

extents are automatically set according to the field groups selected. 

 

 

 

Select the visible 

field groups from 

the tree view. 

Selecting field groups changes the 

visible extents of the map. This 

map has the Geoanalysis layer 

Auto Crops selected allowing the 

fields to be coloured by crop 

type. 
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Part 5: Gatekeeper Mapping Layout and Tools 

Below is a screen shot of the Farm Map screen. The active tools that are available differ 

depending on the top layer that is selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Active Tool Options 
Displays the style, measurement and applicable details for the selected tool.  

 The Headup Display options located at the bottom of the Active Tool Settings screen 

contain further mapping options. These are also available while drawing using the right 

mouse click function: 

 

 

 

 

  

 

Side-Bar Icons: 

 Active Tool Options 

 Map Layers 

 Fields 

 Geoanalysis 

 

Utilities Menu 

 

Tools 

 

Active Tool 

Settings 

Side-bar 

 

Map Scale Selector 

 

Scroll Bars 

 

Head-up Display 

 

Snap to previously 

drawn points for 

accuracy when 

drawing 

 
If unable to locate a 

snap point, no further 

action will be taken 

 

Snap ‘grab’ area 

can be increased 

/decreased 

Used to grab 

multiple ‘snap’ 

points on a line 

when drawing 
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The Headup Display settings are also available from the right mouse button menu. This will 

assist you when drawing by allowing you to navigate through your map layers and still 

control the Headup Display options at the same time via the right click menu. 

Map Layers 
Map Layers contain the different map types to be displayed including the MS Bing Maps 

backdrop browser. Although multiple layers can be displayed, it is only the top layer that will 

be editable which is controlled by the layer ordering tool on the side-bar. This also contains 

a Top layer fader control. The layers that can be displayed are as follows: 

Cartographic Layer Groups Contains three defined layer groups: 

1. Background Layers e.g. OS Open Data 

2. Imported Map Layers e.g. imported Amais data 

3. User Map Layers e.g. Environmental Scheme 

agreements  

New groups can be added containing a variety of layers for 

you to create your maps. Each layer can have different 

drawing styles. 

Field Features All Years For perennial management features e.g. telegraph poles.  

Pre-defined layers organise your field features. 

Field Features Cropping 

Year 

As above but for the current cropping season. 

Field Guidance Holds guidance lines that have been imported from 

compatible controllers or created yourself. 

Field Region Boundaries Contains both Cropping Year and Whole Field boundaries. 

A “heads up display” 

of information based 

on the cursor location 

with or without a 

background 

Magnifier for 

detailed work 
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Field Zones All Years Perennial management zones for Precision Farming Target 

operations e.g. soil types. 

Field Zones Cropping Year As above but for the current cropping season e.g. weed 

types. 

Geoanalysis Auto Auto-generating report layers for Crops, Field Groups, Field 

Names, Varieties and Whole Field information (some 

include colour). 

Geoanalysis User Defined Contains user-created layers to display field or job records. 

Image Maps Contains scanned images e.g. drainage maps. 

 

Field Groups 
The Field Groups icon determines the field groups that are visible as well as the map 

extents. The selected field groups will be highlighted Blue in the tree view. 

Geoanalysis Setup Layers 
The Geoanalysis icon allows the user to add and setup mapping queries and the layer that 

they are saved on. The user defined geoanalysis layers are used to show jobs, features and 

other field based data. These allow the analysis and display of both whole field and variable 

job spatial data.  

A query can be used in any harvest year as it acts as a template, but it must first be 

refreshed in the cropping year you wish to display the data for. Unlike the Geoanalysis Auto 

layers, if the underlying data or the query criteria changes, then it must be refreshed in 

order to reflect the underlying data. To create a Geoanalysis layer see Part 7: Geoanalysis  

Utilities Menu 
The utilities that are available for use are displayed at the top of the mapping screen in the 

Utilities Menu: 

 
Library Map Allows two maps to be displayed side-by-side. The Active 

Tool Settings, Map Layers and Job Data icons are 

duplicated for the library map allowing any combination 

of maps side by side.  

 

Save Saves any edits that have been made and leaves you in 

the mapping screen. 
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Reports Available in Farm Map mode only. Produces a whole 

farm map report. Report options include map keys & 

scale and whole page/half page maps. Sub-reports can 

be included for Cartographic Layers e.g. ELS feature(s) 

area, length or count. 

 
Print Prints the displayed map. 

 
Copy To Clipboard Copies the current displayed map layers to Windows 

clipboard. 

 

Default Toolbar 

Layout 

Reverts the top menu, active tool and mapping icons to 

the default layout. 

 
Cancel Cancels back to last saved data. 

 
Scale in/Scale out Click to zoom in/out. Alternatively set the map scale in 

the bottom right of the screen. 

 Clear Measurement 

 

Clears any measurement marks made by the measuring 

tools. 

Tools 
The tools available for selection will depend on the top layer that has been selected. The 

following list details all of the tools available regardless of the layer they appear on: 

 
Scale to Box Draws a rectangle around an area to zoom into. 

 
Field View Opens the Field Map from the Farm Mapping module, 

or field records from a Field Map view. 

 
Field Boundary 

Polygon 

Used to create a field boundary. 

 
Polygon Draws a polygon shape on the map in the set style. 

 Sub Polygon Draws a sub-polygon to a previously drawn polygon. 

Can be used where a field is divided by a track. Area is 

included. 

 
Island Polygon Draws an island polygon to a previously drawn 

polygon such as an in-field wood or pond. Area is 

excluded. 
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Split Polygon Splits the selected polygon into two separate ones. 

 Polyline Draws a line on a Cartographic layer. 

 
Polygon Shift Increases or decreases a polygon shape by a set width. 

 
Headland Draws a headland or field remainder polygon either 

inside or outside of a polygon. Headland width set in 

metres. 

 
Bearing Draws two points to make a line pointing from the first 

point to the second to provide a bearing. 

 
Parallel Line Draws a parallel line which may optionally become an 

enclosed polygon. The width can be set in metres. 

 
Arrow Line Draws two points to make an arrow pointing to the 

first point and optionally double ended 

 
Rectangle Draws a rectangle by left clicking in its diagonally 

opposing corners. 

 
Circle Draws a circle. The radius can be changed using the 

settings. 

 
Symbol Inserts a symbol such as a tree with or without 

accompanying text. 

 
Grid Lines Creates a set of grid lines aligned to a drawn line.  The 

axis spacing is user defined.  

 
Add Feature Available for use on the Field Feature layers. It allows 

you to add a feature from the Active Tool Settings 

drop down list. 

 
Edit Feature Data Edits the selected features type and any other 

associated data. 

 
Text Adds new text, picking from the comment selector or 

free typing. This tool also allows you to add a point 

and a map coordinate to a cartographic layer. 

 
Waypoints Draws a polyline representing a sampling route. Each 

mouse click inserts a new waypoint with the waypoint 

number increasing numerically. Waypoints can be 
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exported to Farm Works software (requires the 

Precision Farming modules). 

 
Change Entity’s Style Changes either a whole or sub entities style by picking 

from the selected style.  If this tool is used on a Field 

Zones layer, it is known as Change Polygons Zone tool. 

In this scenario, you can find a zone polygon and 

change its style to the current selected zone style. 

 
Change Polygon’s Z-

Order 

Available for use on the Field Zones layer. Polygon 

zones when drawn may overlap each other. The Z-

Order controls the order that the zones appear and 

are used (e.g. the Target Grid Generator). The right 

click menu assists in moving zones up and down the Z-

Order. 

 
Insert New Point Inserts new points to a drawn entity. 

 
Move Point Moves an existing drawn point. 

 
Move Entity Moves an entire drawn entity. 

 
Delete Point Deletes a point within an existing entity. 

 
Delete Entity Deletes either a whole entity or sub part. 

 
Rotate Find a point within an entity and rotate the entire 

entity about this point. Useful for altering the bearing 

direction. 

 
Clipping Deletes all points inside or outside of a polygon. Left 

click to draw the polygon and right click to clip points 

inside or outside (use with caution as it can result in a 

loss of data). 

 
Measuring Polyline Draws a measuring line. 

 
Measuring Polygon Draws a measuring polygon detailing the area and 

circumference. 

 

Measuring Circle Draws a measuring circle of given radius. 

 
Measuring Headland Measures the area of a headland or the field 

remaining area. 
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Measuring Parallel 

Lines 

Draws and measures the length and area of parallel 

lines. 

 
Measuring Grid Lines Draws and measures grid lines. 

 
Geo-Reference Image Available on the Image Maps Layers. The screen is split 

in two allowing a point to be marked on an image 

(right side of screen) and a corresponding point on the 

map screen (left side of screen). This action is 

repeated twice to align the imported image. 

 
Drag Visible Map Uses the left mouse click button to drag the visible 

map around the screen. 

 
Pointer A safe tool that makes no edits the map. 

Job Layer Tools 
When viewing job maps (e.g. Yield Map) different tools appear on the screen appropriate 

for viewing and editing spatial data. The following job layer tools are available: 

 
Edit Plot Data Edits single or whole job data plots or filters them 

out. The right mouse button menu selects the 

appropriate editing method e.g. filtering high yield 

plots that may affect the outcome of a variable 

prescription. Filtered plots remain logged against 

the field but can be hidden from view. 

 
Re-grid Job Changes the extents of actual gridded job data to 

the field boundary. Can be used to tidy up recorded 

job data. 

 
Map Summary 

Information 

Draws a polygon around plot data to display data 

e.g. finding the quantity of yield recorded in a 

certain area. 
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Changing/setting pen and fill styles. 
The Cartographic layer tools can have their styles defined/edited.  

1. With the appropriate Cartographic layer selected and made top, click on the Active 

Tool Options . 
2. When a drawing tool is selected, the Active Tool Settings menu will show the current 

style which can be changed using the drop down list. If a particular setting is not 
available, click on the Setup button. 

3. The Setup Mapping Cartographic Layers and Styles screen will appear allowing the 
user to add a Cartographic Group, Layer and Style. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

New Styles can be 

added to existing 

layers. Alternatively, 

you can create your 

own Cartographic 

Groups and Layers. 

 

Style name can 

be changed. 
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Part 6: Moving onto next year  

Region management 
A Region links a boundary to a cropping record. A region can be for either a whole or part 

field. When a field is created or divided, a region will automatically be created for those 

parts.  

Each cropping record can only have one boundary (and therefore one region) active at any 

one time. If the region details of a cropping record change (e.g. boundary shape due to a 

new building) a new region can be created with a new boundary allocated whilst the 

cropping records remain unchanged. Subsequent regions can be created within the Region 

tab located within the Cropping Records. 

When setting up the cropping for the next season, a previously created cropping record can 

be re-used. This includes any associated field region details.  

Please note: Region management only applies when the optional mapping modules are 

enabled. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Within the Cropping 

Record screen, the Region 

tab will display the linked 

field boundary 

 

This boundary is for 

Cropping Record - Part A of 

the field 

 

This boundary is for 

cropping Record – Part B of 

the field. This shows the 

headland area less the 

cropped area (Part A) 
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Utilising previously created regions  
When setting up cropping for the next season, previous whole or part field cropping areas 

can be reused. If the region details remain unchanged for each cropping area (i.e. boundary 

shape) these will automatically be used. 

1. Browse to Setup Fields from the main menu and double click in the Cropping Summary 

grid for the field and year that is being setup .  

2. On the ‘Add Field To Cropping Year ...’ screen ensure the correct source year to copy 

from has been selected from the drop down list (it will assume that you are copying 

from the previous year). Select the field/part--fields that are to be re-used providing 

they have been setup.  

 

Double-click in the grid cell for 

the field that is being setup in the 

appropriate cropping year. 
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3. Continue to the Cropping Record screen and allocate the cropping as appropriate. 

Allocating boundaries to new field regions 
Sometimes, a new boundary will need to be created to a cropping record where a boundary 

has already been drawn. A new field region will preserve the previous boundary for future 

use or if there is any map data associated with it (e.g. yield map). 

 

If a new field region is required, it will need to be created before a new boundary can be 

allocated to it. New field regions are created within the Region tab located within the 

Cropping Records. (These regions could be for boundary changes in either whole or part 

fields). 

Creating new field regions 
1. Browse to Setup Fields from the main menu and double click in the Cropping Summary 

grid for the field and year that is being setup.  

2. Browse to the Cropping Record screen for the appropriate field and click on the Region 

tab. 

3. Click on the Setup Field Region button. The screen that appears will show any whole 

or part field regions that have been created for the field. If a boundary has been 

allocated to that region, a globe symbol will be displayed against it in the tree view.  

 

 

Select the 

source year. 

 

Select the 

source field. 

 

Highlight the part-fields that 

will be copied. If the field has 

not been split, you will only 

copy through the whole field. 
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4. To add a new region, click on the Add Whole/Part Field Region button at the top of 

the page. If a whole field region is added, the previous one will become inactive (there 

can only be one whole field region). If a part-field region is added, the reference 

number will increment alphabetically. The field areas, boundary description and 

Buffer zone details can be entered on this screen. OK the changes and exit the screen. 

5. If a part field region has been added, the existing part field region can be swapped for 

the newly created region by clicking on the Swap Region button on the Setup Fields 

screen. 

 

 

 

 

 

 

 

 

 

Click here to add a new 

Whole Field Region 

ready to receive a new 

boundary. 

A Whole Field 

Region with a 

boundary. 
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6. On the Field Region Selector screen, browse to and select the new part field region 

from the tree view. Any regions that have already been allocated to cropping records 

will be indicated by a ‘No Entry’ symbol. These regions cannot be selected. 

 

Once the region has been swapped, a new boundary can be drawn and saved to the field region  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When a field is created 

or divided, a region is 

automatically created. 

The globe indicates that 

the field has a boundary 

linked to it via region 
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Part 7: Geoanalysis 
Geoanalysis layers are available as default layers (Auto) or can be created by the user (User 

Defined). Geoanalysis contains five ‘Auto’ layers (crops, field groups, field names, varieties 

and whole fields) known as queries. Each query applies a pre-defined colour/style to the 

fields representing the appropriate attribute (e.g. crop type). The Auto layer will be applied 

across all field groups, but the field groups will need to be selected in order to display them 

on the map.  

User Defined Geoanalysis queries can be created by the user, based on a Field search (field 

details) or Job Data (with or without maps). A Query acts like a template containing the 

criteria that the map will be based upon. Once a query has been created, it is linked to a 

Layer. There is only one query linked to a layer at a time. The User Defined layers can be 

used across cropping years and businesses; however each layer must be rebuilt in the 

year/business that the map data is to be displayed. Once the layer has been setup and 

displayed, it is stored as a ‘snap shot’ and can be selected again for display from the Map 

Layers tree view. If any of the underlying data or the query parameters change, then the 

layer must be rebuilt in order for the map to display an accurate query representation. 

Creating a Field Search Query 
A Field Search query can be created based on the field details (e.g. previous cropping). Any 

fields that meet the criteria set out in the parameters can be attributed with a colour and a 

caption. The following example is based on previous cropping. 

1. Click on the Farm Map module. 

2. Click on the Geoanalysis icon  on the left of the screen and then click on the Add 

Layer button. 

3. A new layer will be created and the Layer Name will be highlighted. Enter in the layer 

name (e.g. Last Year’s Crops). Now the layer has been created, a Geoanalysis query 

can be created and linked to it. Click on the Setup Queries button. 

4. Click on the Add Query button that is displayed at the top of the Query tab and add in 

the name of the query (e.g. Previous Cropping). Similar queries can be created but 

only one is linked to the layer at a time.  

5. Ensure the Query Type is selected to Field Search Map and select any captions that 

are to be displayed with each field. To initialise a caption, tick the box and from the 

drop down list select the appropriate caption text. Underneath the caption type, an 

Append to caption box will appear. This allows you to enter additional text that will 

appear alongside the caption.  
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6. Next, click on the Searches tab. A search will have been created automatically and 

appointed a colour (these can be edited). Each search can have its own name (e.g. 

Wheat Winter). Highlight the appropriate search parameter and using the single blue 

arrow move the highlighted parameter across to the selected grid. The parameter 

name will appear in the first column (e.g. Previous Crop Name followed by a 

Comparison and Data column. Double click in these columns to change the grid cells 

as required (see screen shot below).  

Enter the name 

of your query 

Name each search 

parameter (e.g. 

Winter Wheat) and 

assign a colour 

 

Select any captions that 

you wish to be 

displayed on your map 

 

Select either 

Field or Job 

search to create 

your query 
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7. Once a search has been created for each of the crop types that have been growing on 

the farm, the layer is ready to be built. Click OK.  

(Alternatively, the Autogenerate button can be used which automatically selects the 

crops you are recording and associates a colour with them)  

8. The Rebuild Geoanalysis Layer window will appear informing you which Layer, Harvest 

Year and Query is going to be rebuilt. If this is correct, click OK. If the wrong query has 

been linked to the layer, click Cancel and re-link correctly using the drop down boxes 

in the toolbar on the left hand side. Then click on the Rebuild Layer button. 

9. Once the layer has been built, the map will be displayed (e.g. previous cropping by 

colour) including any selected captions. If any of the parameters of underlying field 

data change, the layer will have to be rebuilt. If the displayed layer is out of sync with 

the query, a red warning line will appear under the Rebuild Layer button prompting 

you to rebuild. 

Add search 

criteria using 

the parameters 

 
Once the parameter has been set, 

click in the cells to amend the 

comparison and data values 

 

The completed map query 

displays your selected criteria 

such as this crop identification 

map with two captions appended 

(current and previous crop) 
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Creating a Job Data Query 
Job based queries can be created based upon spatial data (e.g. Yield map) as well as non-

spatial job recordings. The following worked example will look at creating a query reflecting 

recorded yield data for all crop types for both spatial and non-spatial data. 

1. Follow steps  1-4 of section 7.1  

2. Ensure the Query Type is selected to Job Data Map. The caption options apply as 

before with the Field Search Map. 

3. At the bottom of the page is the Query Map Key section. Use the drop down menu to 

select the appropriate key for the query (there is a pre-defined key for Yield 

Combinable Crops). NB.: the selector button next to the drop down menu takes you to 

the Setup Key menu where keys can be created and modified. Edit the key contours as 

required.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Next, click on the Job Data tab. Select the Job Data Source Type option from the 

dropdown menu at the top of the page (e.g. Operations (cropping year)) and apply a 

date range if required. 

5. Next, select either a Heading or Product name to be displayed. For this example, we 

have selected the Heading type as Combine Crops by clicking on the selector button 

and browsing to the Combine Crops node in the tree view. 

.  

 

Enter the 

captions as 

appropriate 

Add a Job Data 

Map query and 

enter a name 

 

Select the Query 

Map Key from 

the drop down 

list. To edit the 

key, click on the 

selector button. 
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6. Select the appropriate Summing Method option. The summing method lets you 

choose how the field’s job data is to be treated. This will be of importance if there are 

multiple operations recorded on a field in the same year. The options can let you sum, 

average or use the last job. Choose from: 

a. All matching jobs total rate/sample  

b. All matching jobs average rate/sample  

c. First matching job (this is the method used for  this worked example) 

7. Once the method has been chosen, select the appropriate Map Format from the list 

on the right hand side of the screen (we have chosen Actual Filled Contours) 

8. On the Source Jobs options, select either Use all jobs or Only use jobs with spatial 

data. 

9. Once the query has been created, click OK to save the changes and exit the setup 

screen. 

10. Once back on the Farm Map screen, the Rebuild Geoanalysis Layer window will appear 

informing you which Layer, Harvest Year and Query is going to be rebuilt. If this is 

correct, click OK. If the wrong query has been linked to the layer, click Cancel and re-

link correctly using the drop down boxes in the toolbar on the left hand side. Then 

click on the Rebuild Layer button. 

11. Once the layer has been built, the map will display the queried data with the key. If 
any of the parameters or underlying field data change, or you require the map in 
another cropping year, the layer will have to be rebuilt. If the displayed layer is out 
of sync with the query, a red warning line will appear under the Rebuild Layer button 
prompting you to rebuild the layer. 
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Part 8: Precision Farming Overview – Yield Data 

Imported yield maps update field records, adjust stock quantities and allow maps to be 

analysed and printed. Depending on the type of display unit, the Farm Mapping, Precision 

Farming Actual or John Deere Devices modules will be required. 

Importing Yield Data 
All precision farming data is imported and exported through the Devices module. This 

example deals with importing a Yield map from a John Deere GreenStar 2600 display, 

although the principles are the same for yield maps from other data displays. Before data 

can be imported, the device must be setup on Gatekeeper. It is recommended that a Work 

Plan is created on Gatekeeper and the yield maps and recordings are imported to it. 

1. Click on the Devices module. 

2. Click on the Setup Devices button at the top of the devices page. 

3. In the tree view, browse to and highlight the correct Controller type (e.g. John Deere 

GS2 2600). Click on the Add button at the top of the page.  

4. Enter the name of the device by overtyping the text in the Name box (e.g. registration 

number). Click OK to display the device name in the tree view and return to the main 

device screen. 

NB. You can have several devices listed under the same type. Each device name will 

list its associated records. 

5. With the device name highlighted in the tree view, click on the Device Sync button. 

6. There are a number of device import options (see imbedded help for further 

information).  It is recommended that you have the Preview imported data… option 

applied. This will let you view the recording before it affects your field records and 

stock and allows you to cancel the import. 

7. Click on the Import tab. 

8. Browse to the location of the files that you wish to import using the selector button at 

the end of the Path box  (the Path is the location of the files).  

9. The Data To Import grid will list the files to be imported along with a summary of their 

contents. This will assist in ensuring the correct files are imported. There may be more 

than one file for an individual field due to interrupted recordings. Each file will be 

coloured and displayed in the Source Device columns. The file types are denoted by 

the following colours: 

 Red - Operation Jobs 

 Green - Field Boundaries 

 Orange (beige) - Field Features 

 Yellow - Machinery Settings 

 Blue – Sampling 
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 Purple – Field Guidance 

10. If you have already created a work plan on Gatekeeper and you are importing the 

completed files to it, you can use Gatekeeper to link the files for you. Work across the 

Gatekeeper Destination columns as required.  

  
If you haven’t exported a 

Gatekeeper plan to your display, 

you need to assign the imported 

recordings to a work plan on 

Gatekeeper. Click here to link. 
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Ticking this box allows 

Gatekeeper to link 

other fields that are 

in the plan to their 

respective recordings. 

Click OK. 

Browse to and select 

the Job that the field 

belongs to. 

 

 

On returning to the 

import screen, the 

remaining records have 

been linked to the correct 

job. Click on the Import 

With Preview button. 
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11. You will now preview each of the files to be imported and can cancel if you are not 

happy. 

12. With the selected files imported, OK out of the Device Synchronisation screen back 

to the Device module home page. 

 

The yield recording and map are 

accessible for the Fields module 

by clicking on the map and job 

entry. 
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Filtering yield data 
After importing a yield map, it may be necessary to edit the plot data. This could be due to 

spurious plot values (e.g. high values due to stones hitting the mass flow sensor), header 

overlap or where the combine speed is slow or fast. When editing or filtering recorded plot 

data, the field totals will remain the same, but the resulting map may be more useful as a 

reference for a variable rate application. Templates can be created to save time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Open the yield job by double clicking on the job entry within the Fields module 
operation grid (the job entry will have a globe symbol indicating the presence of a 
map) or browse to the work plan or record. 

2. Open the record and on the Record Work Done screen, click on the Fields tab and Map 

sub-tab. The yield map will be displayed for the first field within the job (see overleaf).   

3. Click on the Filter Plots button to bring up the Filter Plots screen. 

4. Create a new filter by clicking Add Filter and providing it with a relevant name. The 

example filter has been named “Min-max and overlap discard”. 

5. Work through the page selecting the options to initialise the permissible criteria and 

entering any values where applicable (see overleaf). 

6. The fields to be filtered will be displayed on the left of the screen. Ensure they are 

highlighted blue to have the filters applied. 

This has affected the 

contour map, indicating 

areas of poor yield. 

The low yield plots can be 

seen, showing where the 

combine has navigated 

around the telegraph 

poles. 
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7. Click on the Filter Plots button at the bottom of the page. This will then apply the filter 

to all of the plots for the selected fields. If the resulting filter is not correct, click Use 

All Plots to restore the plots to their original recorded state. 

 

 

 

Click on the Map sub-tab 

on the Fields page to bring 

up the map options. 

You will need to go 

back into the 

recording setup of 

the yield job to 

filter the plots. 

Filter for the 

Min/Max rate 

Filter for header 

overlap 

Highlight the fields 

to be filtered 

 

Select to filter plots recorded 

outside of the field boundary 

 

Plots can be 

filtered where the 

machine is 

below/above a set 

speed 

 

Click to filter plots 

 

The Start of pass 

delay will remove 

plots where the 

combine is not 

fully in work 
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A Filter Plots notice will appear informing you of how many plots have been filtered 

out. Click OK and you will be returned to the Recording Work Done page. 

Click on the Field Map button to display the filtered yield map. Any plots that have 

been filtered out will be displayed on the map as a hollow grey circle. 

 

With the data filtered, a variable application map can be created ensuring that unwanted 

influences are ignored. 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The low yield plots 

around the telegraph 

poles have now been 

filtered out 

The contour map 

displays the yield off-

take in a more 

‘realistic’ map 
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Calibrating Yield Data 
Yield quantities can be adjusted for individual or multiple field recordings either by quantity 

or by adjusting the calibration factor (John Deere GreenStar yield imports only).  

1. Open the yield job within the Planning or Recording module (depending on how the 

job was imported). 

2. Browse to the Fields tab and Map sub-tab. The yield map will be displayed for the first 

field within the job. 

3. Click on the Calibrate Job button.  

 

4. On the Calibrate Job Map Plots screen, the product that has been recorded will be 

displayed along with the individual recordings. 

5. Select the appropriate method to either update the job total, sub-total for the 

selected recordings or the calibration factor (see overleaf). 

  

Click on the 

Calibrate Job 

button 

Click on the Map sub-

tab on the Field page to 

reveal the map options 

 



 
 
 

 
  50 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. To provide a new subtotal quantity for individual fields or part field recordings, select 

the New subtotal quantity method and the field recordings from the grid by ticking 

the box next to the field name. 

7. Enter the new subtotal quantity figure in the box and then tick the Update job total 

quantity used box for the figure to be used if applicable. Click the Calibrate Plots 

button. 

8. To reset the quantities, ensure the Reset to original method option is selected, tick 

the Update job total quantity used tick box and click Calibrate Plots. 

The Job total used is 

displayed at the top of the 

page along with the product 

which can be changed 

New sub total quantity. The 

calibration factor will be adjusted for 

selected fields within the job. Ensure 

the fields are selected in the grid. 

Enter the quantity that you wish to 

use into the New sub total quantity 

box at the bottom of the page 

 

Tick box to 

Update job total 

quantity used 

Calibration Factor. Enter a 

calibration factor for the selected 

fields. Enter the calibration value 

that you wish to use into the 

Calibration factor box. 

 

The Job total used is displayed 

at the top of the page along 

with the product which can be 

changed 
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Part 9: Precision Farming Overview – Variable Rate Applications 

Variable rate applications created in Gatekeeper can be exported to compatible devices via 

the Precision Farming Target module. A variable application target map is created through 

the Grid Generator which is used within a work plan. 

Variable rate maps can be based on yield, sampling, sensing or management zone maps in 

combination with each other or on their own. 

 

  

 

Example of a fertiliser 

application map based on 

the fields ‘P’ samples. 

Application maps are 

based upon 10m2 grids 

The same field with 

the fertiliser 

application based 

upon Yield off-take 

The final map is of the same field 

with its variable application map 

based upon soil sample values in 

combination with yield off-take. 

The map will also provide the 

target job requirements. 
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Grid Generator 
The Grid Generator tool allows you to produce a variable application map that is attached to 

a work plan. This work plan (along with the variable application map) can then be exported 

to a compatible control device where the parameters set by the grid generator will be 

recognised during the variable rate application.  

The optional Farm Mapping and Precision Farming Target modules must be purchased in 

order to create a variable application map and export to the control device. Completed 

work plans and maps are imported through the Precision Farming Actual module.  

Grid Generator Requirements 
The Grid Generator will base its calculations on known values. These values can be taken 

from the zones within Gatekeeper Mapping (see 9.4 Creating Zones) or spatial data such as 

yield maps (See Part 8: Precision Farming Overview – Yield Data). 

Zones 
A Zone Polygon can be drawn on the field using the polygon tool. The zones can be free 

drawn or based upon another mapping feature (Cartographic layers, Image Maps or 

imported Job Data such as soil samples). If the zone polygon is used by the Grid Generator 

to create an application map, the application map grid will consist of 10m² grid cells applied 

to the whole field. Each grid cell can adopt a value which can be created and set by the user. 

This could be for a soil type as in the worked example or even a management area such as 

Black grass. Zones can be created for the current cropping year or for all years.  

Creating Zones 

1. From the Fields module select the appropriate field from the tree view.  

2. With the field highlighted, click on the Field sub tab which will bring up the Field 

information.  

3. Next, click on the Field Map button (If a boundary has not been created, the Setup 

Boundary Map button will be displayed. See Part 2: Getting started). 

4. From the Field Map page that is displayed, select the Map Layers icons .  

5. Expand the Field Region Boundaries node in the tree view and highlight the Field 

Boundaries Cropping Year node. The boundary needs to be displayed in order to 

create the zone. 

6. Expand either Cropping Year / All Years Zone Grids as applicable in the tree view and 

highlight an appropriate layer e.g. Soil Types.  

7. Ensure that the zone grid layer selected is the top layer by highlighting it in the Layer 

Order section at the bottom of the tree view and clicking on the Make Top button (any 

layer being edited must be the top layer). 

8. Next, click on the Active Tool Settings icon . Select the Polygon tool and then click 

on Select Zones. 
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9. This will open the Setup The Used Zone Names List screen. Select the zones to be 

drawn by clicking Pick Zone Names and selecting the zone(s) from the tree view (NB; 

there will always be an unallocated layer).  

 

To create new zones, click on the Setup Zone Names button at the bottom of the Field Zone 

Names Selector screen. The Setup screen below will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Once the zones have been created/selected, OK out of the setup screen. The selected 

layers will be displayed in the Active Tool Settings side bar menu. 

 

 

 

 

 

 

 

 

 

 

Add a group and/or 

add a new zone 

Name the zone and 

allocate a colour for 

reference 
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Drawing Zones 

With the zones now chosen, they can be selected and drawn on the field. Not all of the field 

has to be allocated a zone. Areas can be left as ‘unallocated’. If different management zones 

are required, these would be created on a separate zone grid layer. To assist in drawing, a 

predominant zone in the field can be drawn across the whole field followed by smaller 

zones on top. The ‘Z’ Order tool will assist in arranging the zone layers afterwards. 

1. Select the zone style to be drawn by highlighting it in the Active Tool Settings menu. 

2. Next click on the Polygon tool and then left click in the field to draw the zone. Once 

you have finished drawing the area, right click with the mouse and select Finish This 

Entity. If you go out of the field area, the zone will only be applied to the field area 

only. 

3. You can keep on creating the zones, selecting each one from the key in the Active Tool 

Settings. If you draw over an existing zone, the zone style will be seen uppermost. 

4. To change the order that the zones appear on the screen, use the ‘Z’ Order tool  . 

With the tool selected, use the right mouse click menu options to move the zone 

polygon down or up. It is important to remember that the Grid Generator will act on 

the zones as they appear on the screen and will ignore a zone if it is obscured by 

another. 
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5. Once saved, the zones can be used for the basis of a variable application plan. 

 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

  

As this field has a 

predominant Medium soil 

type, the zone has been 

drawn across the whole field 

to start. The boundary forms 

the extent of the field’s zone. 

Select the zone to 

be drawn and the 

polygon tool 

The completed zone 

map drawn for 

different Soil Types. 
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Applying a Variable Application Map to a Work Plan 
Before a variable application map can be produced, a work plan must be created. On 

exporting the variable prescription to a compatible control device, it may be accompanied 

by the work plan depending on the level of compatibility the control device has with 

Gatekeeper. 

1. Within the Planning module, add a work plan as normal with a Field Operation Job. 

Select the fields, products and implement required for the job (this example will be 

applying seed based on the soil zones created on the previous pages). 

2. On the Planning Setup screen, click on the Fields tab, Map sub-tab and tick the box to 

Provide variable application target maps for ALL fields in this job. A map of the field 

will be displayed with an empty grid overlaid if the product selected had no rate OR 

with a single solid colour if the product did have a rate. You are now ready to use the 

grid generator. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Fields page showing the tick 

box applied to provide a variable 

application map. 

The Target Grid Generator 

button allows you to setup and 

use grid generator templates on 

the map 
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Target Grid Generator  
The Target Grid Generator contains grid generator templates created by the user. Each 

template can contain one or more computations. A computation is a set of questions that 

can be asked of each grid cell on the field. For example, a computation can be created to 

look at a field’s spatial data (e.g. ‘P’ sample indices or yield data) or a management zone. It 

is possible to have more than one computation within a template, e.g. Fertiliser application 

in response to soil sampling and yield data with each computation adding, subtracting or 

replacing cell rates. 

Once a template has been created, it can be applied to all fields within a variable rate job 

and can even be utilised again year after year. 

Setting up and applying the Grid Template 

1. Click on the Target Grid Generator button on the Fields tab of the work plan (see 

previous page). 

2. On the Target Grid Generator page, any templates previously created will be listed in 

the tree view. If a suitable template exists, highlight the template, fields and product 

and click on the Generate Grid button to create a variable map. If a suitable template 

does not exist, click on Setup Template.  

NB Once you have worked through the Template and Computation setup, you will be 

returned back to this page in order to generate the grid. 

3. On the template setup page, click Add to add a new template and provide it with a 

suitable name. Work through the template setup entering details where applicable. 

 

 

  

 

 

 

 

 

 

 

 

 

Default Rate – used 

on all unallocated 

grid cells 

Min/Max Final Cell 

Rate Allowed  

Multiplication 

Factor – set to 100% 

as default. Used to 

manipulate rates 

without recreating 

the template 
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4. Click on the Computations tab. The first computation sequence will be displayed in 

the computations grid. The details of this computation are set overleaf in the 

computation details. Work through the options and set the sequence bands for the 

computation. In this example these will relate back to the three soil zones previously 

drawn. 

 

5. With the computation(s) set, click OK to return to the Target Map Grid Generator 

page. With the template, field(s) and product(s) highlighted, click on the Generate 

Grid button. When successful, the Map Grid Generator Logs screen appears informing 

you of the fields that the grid generator has been applied to. Close out of this screen 

and OK back to the Planning Setup page.  

6. The field will be displayed with a range of coloured variations in the 10m² application 

grid cells. Each grid cell has now adopted a different application rate. This can be 

viewed further by clicking on the Field Map button.  

7. Once in Field Map mode, the Active Tool Options will display the key. With the Display 

Data tick box applied in the Headup Display options, the grid cell values will be 

displayed when the cursor is moved across the field. 

The computation type 

can be set to reference 

against a Job or mapped 

features or zones 

Rate Summing - with more 

than one computation, you can 

add, subtract or replace one 

from another. 

 

The bands determine how the underlying job or 

mapped features/zones are to be referenced. 

Work through the columns by clicking in the grid cells 

to adjust and amend the lookup values and rates.  

s 
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The variable rate plan is now complete. The grid generator will have calculated the job total 

requirement for the product being applied. This will be displayed on the product tab within 

the plan and through the work plan reports. Once the plan has been issued, it can be 

exported to a compatible device through the Devices module. 

 

 

 
 

 
 
 
 
 
 
 

Library Map Function 
The library map function allows two maps to be displayed side-by-side. With the Display 

Data tick box selected within the Active Tool Settings on the Field Map page, the map data 

on each map will be displayed for the same map location. 

 

1. Click on the globe adjacent to the field name in the Operations grid in the Planning 

module to bring up the Field Map screen. 

2. Click on the Library Map icon which as default is located in the top left hand corner of 

the Field Map screen. You will notice that the current displayed map will now have 

been duplicated and shown on the right hand side of the screen. The library map will  

3. be indicated by a library symbol .The Active Tool Options, Map Layers and Job Data 

icons have also been replicated and will appear on the left hand side of the screen 

with the library symbol attached. These icons control the library map. The full range 

of map layers can be viewed on the left hand map and the right hand map will display 

Cartographic, Image and Job map layers. 

4. Select the Map Layers to be displayed on each map by clicking on the appropriate Map 

Layers icon and browsing to and highlighting the correct layer in the tree view 

ensuring they are the top layer (e.g. Field Zones on the left and Job Data on the right). 

5. Clicking on the Library Map Job Data icon  will also allow you to select and display 

previously stored spatial maps for the selected field from the Jobs Library.  

6. With the Job selected from the Jobs Library list, select the Displayed Job Data type (at 

the bottom of the page) i.e. Actual Filled Contours. This will then show a different 

‘library’ map. 

Snap shot of a field record. The 

globe symbol indicates that this 

recording has a map associated 

with it 
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7. Click on the Library Map Display Options icon  and tick the Display Data box on 

either with or without the Opaque Background selected. This will display the 

appropriate map data for the cursor position on the map. The Library maps Headup 

Display options will need to be ticked on in order for the Library maps Headup Display 

to work. 

8. You will notice that as the cursor moves over the Map screen, a duplicate cursor will 

move over the Library Map screen in the corresponding map position. This will allow 

you to compare the displayed data from the same position in the field.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Library Map icon. 

Click to initialise 

Duplicate Mapping Icons to 

control the Library Map 

 

The Headup Display 

with Opaque 

Background 

 

Library Map illustrating a variable rate 

fertiliser application map (Left) compared to 

a contoured Soil Sample Map (Right) 
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Part 10: Precision Farming Overview – Soil Sampling 
Sample data is displayed within field records in the Sampling tab. Sample data includes soil 

and sensor data.  

Soil Sampling 
Spatial Soil Sample work plans can be created in Gatekeeper using the Farm Mapping and 

Precision Farming modules. Sample plots are assigned to the map based either on a grid 

format or on management zones. This allows for user defined sampling with the grid size 

and orientation being adjustable and the management zones set to your own parameters. 

The sample plan and map can be exported from Gatekeeper to a compatible device allowing 

the user to navigate to the sample plots. A sample map can also be printed out. 

Once sampling has taken place, values can be assigned to the plots and displayed in 

Gatekeeper. There are several methods available to display and interpret the influence of a 

sample value. Such as ‘Nearest Neighbour’ or ‘Kriging’. 

Creating sample zones 

1. Ensure a field boundary has been created (see Part 2: Getting started) 

2. Create a sampling zone by selecting the layer ‘Soil Sampling’ within the Field Zones All 

Years layer. Make this the top layer. 

3. Instead of picking zone names, pick the numbers depending on how many different 

zones the field is to be divided into. 
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4. Draw the zones using the polygon tool. Remember that a sampling grid can be applied 

to the field if preferred using the Grid Lines tool  or imported from a third party.  

Creating a Sampling Work Plan 

Work plans can be created for sampling operations using waypoints, sample zones or 

sampling grid. 

1. Create a new Work Plan and add a new Field Sampling job (use the drop down list for 

New Job Type to change the job type on the Add New Job screen). 

2. Select the field(s) and then the Sampling Headings to be included in the job from the 

tree view i.e. Soil Nutrients>P. 

3. Once the job has been created, the Planning Setup screen will be displayed showing 

the Sample Heading columns for each field in the job (the columns displayed will differ 

slightly depending on the heading selected).  

4. To base the sampling plan on a map, click on the Fields tab at the bottom of the screen 

and then the Map sub-tab.  

5. Tick the box to Provide sampling zones for ALL fields in this job. The Heading Selector 

screen will automatically appear.  

NB. With the Provide sampling target maps for ALL fields in this job option selected, 

the Allow actual map data for THIS field and job option will be selected by default. 

This will allow you to spatially record plot values against the target map. 

The field divided into four 

different sampling areas. 
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Option 1 – Sample Map based on Map Zones  

6. Expand the tree view on the Heading Selector screen and browse to and select the 

zone layer that the sample map is to be based on i.e. Soil Sampling. Click OK. 

7. When you return to the Planning Setup screen, the field map will display sample plots 

as per the zone map that was created. 

8. The Work Plan is now ready to be issued. Click OK and then Issue the work plan. 

NB: If waypoints are to be used, select these instead of the zone layer. 

 

 

 

 

 

 

 

 

 

 

Ensure that the Sampling Zone 

layer is selected 

Sampling plan based upon the four 

sampling zones as created on the 

Soil Sampling layer (see 10.2) 
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Option 2 – Sample Map based on a Sampling Grid 

9. To create a sampling grid based on your own dimensions (instead of zones), do NOT 

select a zone from the Heading Selector screen. Instead, click OK to return to the 

Planning Setup screen. 

10. The field will be shown blank, ready for a grid to be applied. Click on the Field Map 

button. 

11. On the Field Map screen, click on the Grid Lines tool from the top of the page .  

12. The Active Tool Settings will change to reflect the selected tool. The Options allow 

you to alter the axis spacing for the sample grid.  

13. Either free type over the dimension or increase/decrease using the arrows. The offsets 

refer to where the grid will be drawn.  

14. Left click with the mouse to add the first point of the grid. This will form a straight line 

that the second click of the mouse will finish. This line will form the first axis of the 

grid which will be applied to the field. The direction that the line is drawn will affect 

the numbering of the plot cells. 

Hint: If the first point is on the intersection and the grid is to be aligned against a field 

boundary, draw the line just outside the field boundary. 

15. If you make an error, simply cancel back to the last saved data and re-draw a new 

grid over the top. Once the grid is set, small areas around the perimeter of the field 

that have adopted individual zone allocations (i.e. their own coloured and referenced 

zone) can be amalgamated with a neighbouring cell to reduce the number of sample 

cell plots. If this is the case, use the change zone tool . Select the replacement zone 

and simply left click. You will see the zone change.  

16. Once the map has been edited, click OK to return to the Planning Setup screen. The 

grid sampling map will be displayed showing the field divided into grids with each cell 

adopting a plot value. 

With a Sampling Plan created with an accompanying sample map, the plan can be Issued 

and either printed out as a Work Plan (Sampling) With Maps within Planning>Reports or 

exported to a suitable device through the Devices module. 
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The sample grid before editing. 

Cell 1 in the bottom left of the 

map is to be amalgamated with 

the Red cell 2 above it 

The result is more 

practical for sampling 

Amalgamate cells by selecting 

the Change Polygon Zone tool  
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Recording Sample Values  

Sample values can be imported into Gatekeeper from sampling labs such as NRM or Yara. 

Alternatively, values can be manually recorded against each sample plot.  

The example looks at manually recording plot values back to the Sample Map based on a 

grid. 

1. Open up the Issued Work Plan within the Planning module. 

2. The Planning Record Work Done screen will appear listing the field(s) being sampled 

and the sample headings. 

3. Click on the Fields tab and then the Map sub-tab.  

4. There are several tick box options on this page which need to be considered; 

a. Allow actual map data for THIS field and job - ensure selected (it will be as 

default if a target map was created). This will allow you to record samples 

spatially to the map. 

b. Actual Map Data Source option - should be selected to From plot data. This 

will allow you to assign a plot value to each cell.  

c. Override gridding method to use the target grid - ensure deselected. This will 

allow you to apply your own contour style to the recorded plots once they have 

been recorded. Otherwise, the plot values influence will be restricted to the 

target grid as created. 

5. Click on the Edit Plots button to record a plot value for each cell. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ensure that this option is 

selected to record values 

The same using the 

gridding method ‘Kriging’... 

 

Ensure selected. A sample 

value will be logged to the 

plot 

 

Click to Edit Plots and 

assign the sample values 
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6. The Edit Mapping Plot Data screen will appear. Click on the Insert Item button  

        
7. The number of Index’s that you need to add will depend on the number of sample 

plots. Keep inserting items to the grid until the appropriate numbers of indexes are 

displayed.  

8. Tick the Reference tick box at the bottom of the screen. This will introduce a reference 

column that allows you to enter each plot reference number corresponding with the 

sample grid. Complete this column. 

9. Work down the Sample column entering the sample value for the appropriate plot 

reference number. NB This will be the parts per million value for the nutrient. 

10. Once the samples have been entered against the correct reference number, click on 

the Position Plots By Reference button next to the reference tick box. This will 

position the reference number and sample value in relation to the plot reference 

number on the sample map. 

11. Once complete, click OK to exit the screen. The sample map cab viewed by selecting 

the ‘Actual’ layers from the tree view e.g. Actual Filled Contours. 

12. The average sample value will need to be recorded and can be generated by clicking 

on the Recalc Total Quantities button. This average value is displayed on the Sampling 

sub-tab. This figure will be stored against the Sampling tab in the Fields module and 

can be utilised for Nutrient Management. 

Once the sampling job has been completed, the job entry will be viewable within 

Fields>Sampling>Soil. A globe symbol will appear against the job entry indicating a spatial 

map exists. Double clicking on the globe will bring up the field map. 

Gridding Methods 
The influence of spatial nutrient samples can be displayed in a variety of gridding methods. 

Each method interprets and displays the sampled data differently. The gridding methods 

available are as follows: 

 Application - intended for actual application data. Each grid cell is given the value of 

the nearest plot to its centre. Contour maps are supported. Not recommended for soil 

sampling. 

 Inverse Distance - should be used when there is plenty of data as the algorithm uses 

a weighted average technique to calculate grid data values. Recommended for harvest 

data. Contour line maps are supported by this method. 

 Kriging - should be used where there is limited data available as the algorithm uses 

trends to predict grid data values. Suitable for soil sampling data where contour line 

maps are required. 
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 Nearest Neighbour - intended for widely distributed data such as soil samples. A plot 

value’s influence will only stretch equidistant between itself and a neighbouring plot 

(see below). 

 Sample Region - should be used where widely distributed data exists that was 

collected on a regular basis. Recommended for soil sampling data. Each grid cell is 

given the value of the plot in who’s region it is allocated. Each plot has a region half 

the plot spacing around it. 

 

 

 

  

 

 

 

P Sample plots 

with values 

P sample data 

displayed as ‘Kriged’ 

Filled Contours 

 

...and ‘Nearest 

Neighbour’ 
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Setting the Gridding Method 

Each sampling heading can have a gridding method applied to it. Different gridding methods 

can be applied to different sampling headings. When contours are applied to the sample job 

data, they will be based upon the method for the selected sample heading. With the Job 

Data map layer selected as the top layer and the job data selected to be displayed, the 

Active Tool Options provides the ability to change the gridding method whilst looking at the 

map. Alternatively, browse to the correct sample heading within the Setup menu.  

1. Click on Setup>Headings from the main screen. 

2. Browse to and highlight the appropriate heading by expanding the tree view i.e. 

Sampling/Nutrients>Soil Nutrients>P (ensure the node is expanded all the way).  

3. With the heading selected, the gridding method can be changed in the Precision 

Farming Map Settings at the bottom of the page. Use the drop down arrow to select 

the appropriate method. 

4. The default map key can also be set e.g. Sampling P index. 

NB Dynamic keys apply banded intervals (either a number of bands or colours) across 

the data values between the min and max values that are recorded on each field. 

5. Once set, click OK to exit the setup menu. 

Applying the Gridding Method 

1. Within the Fields module, browse to and select the field in the tree view to view the 

sample data. Click on the Sampling tab and the Soil sub-tab. 

2. Double click on the appropriate globe in the grid for the sampled nutrient to be 

displayed. The Field Map screen will appear. 

3. Click on the Job Data icon on the left of the screen. Expand the Actual Filled Contours 

node in the tree view and highlight the sample nutrient to be displayed. The field map 

will show the contoured sample value using the selected gridding method. 

4. By clicking on the Active Tool Options icon on the left of the screen, the key will be 

displayed for the sample heading. Another key can be selected using the drop down 

list in the Active Tool Settings menu. 
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Part 11: RPA Boundary data 
RPA field boundaries were available free from the Rural Payments Agency in a format 

suitable for import to Gatekeeper Farm Mapping. If you acquired these boundaries they can 

be imported as a Cartographic Layer where they can be used to create Gatekeeper Field 

Boundaries or left as a reference layer. 

Import the Shapefile supplied by RPA in to Gatekeeper.  
Once you have the data in the appropriate format it can be imported into Gatekeeper Farm 

Mapping quickly and easily. Just follow these steps:  

1. In Gatekeeper, click Setup from the top menu and then hover over Mapping and click 

the Import Map Data option.  

2. Under Path enter the path to the folder containing the RPA shapefile or click the 

button to browse to that folder.  

3. Under File type select RPA Field Boundaries Shapefile (.shp).  

4. Under Options choose Add new Layers.  

5. Under Data to import tick the Import box alongside the file displayed.  

6. Click OK to import.  

7. Click OK on the Map Preview and OK to close the Import window.  

8. To view the imported data, run the Farm Mapping module, click Visible Layers, expand 

Cartographic Layer Groups and expand Imported RPA Field Boundaries. You will see 

two new layers; one text and the other the boundary lines. Select either or both of 

these to display the corresponding data.  
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Part 12 Publishing Cartographic Layers and Data  
Publish Layers and Styles 
You can publish cartographic layer and styles from the setup of cartographic layers and 

styles by clicking on the Publish Styles button  

 

 

Publish Actual Cartographic Layer Entities 
To publish the actual cartographic layer entities, you must be in Farm Map and have the 

relevant cartographic layers selected and being displayed. 

Click on the Publish Tool. 

 

 

 

  

Publish Tool 
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You are presented with the following screen 

 

Published Data 

 Layers, styles and map data. 
This will publish the layer and style definitions as well as the map data. 

 Layer names and styles only 
This will publish the layer and style definitions only 

Source Layers 

 Top Layer only 
Only the top layer is published 

 All visible Cartographic map layers 
All the layers listed below are published 

Map Extents 

 The visable map windows 
The displayed cartograhpic layers, but only what is displayed in the current 

map display window will be published 

 The current map for selected fiedl groups 
The displayed cartographic layers for the selected fields group, even if it 

extends beyond the displayed window 

 All map data for the main business 
The displayed cartographic layers for all fields group of the main business, 

even if it extends beyond the displayed window. 

Clicking ok will display the standard publishing widows were you select the business contact 

for which you have a Gatekeeper key. 


